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The purpose of the Service Calendar in RIMSS is to provide a process for assigning Service Issues from Repair Orders and
Tasks to Service Technicians and Service Employees today and in the future.

Prior to using the Service Calendar, Service Resources must be set up for the calendar. It is recommended that
Appointment labels be set up to help categorize and color code appointments. You will also need the proper defaults set
up for Op and Rate codes. You can find more information on how to set up these items in the help document “Setting up
the Service Calendar”.
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Service - Appointment L=

Save & Close || Create Mew / Goto RO

This G‘\tment OICCLrS iaast.

Subject: o . Service * Customer: Cash Customer (61)
Wholegood: . Service ~ |Resource: LIOM, DAMIEL
Mok { Moded |:| Mobile Service Service Write

ake [ Model: . Shop Cleanup ervice Writer:
Serial Murnber: |:| Training Service Type:

. Transport

Descrint [ rro

escription:

3 . Come Back -
Start time: 4/19/2019 v i0:00AM 2
End time: 4/15/2015 * 1100 AM :
B Link to Existing RO

ROz Service Issue #: RO Date:

Service Issue Desc:

When you dick to add the appointment, you
will get the Service - Appointment pop-up.

1. The subject can be chosen in the drop-down
box. These will automatically color-code and
categorize the appointments for you.

2. If your RO is already created, you can click
"Link to Existing RO" and the appointment will
be auto-populated with the Customer,
Wholegood, Make/Model, SN, Service Writer,
Service Type, RO# and RO information as
shown at the bottom.

3. If you do not have an RO created, you can
populate any of the fields that you need and
add a Description of the Appointment.

4. Save & Close will save then close the pop-up
and populate the appointment on the calendar.

5. Create New/Go To RO will either:
A. Save the appointment and Open the
RO that you linked.
B. Create a New RO (if one is not linked)
using the Customer, Wholegood, Service
Writer, Service Type, and Description (on
the Service Issue). A labor line will be
created if the resource is a Service
Technician using the location default Op
Code, Rate Code, and Accounting Code.




Linking to an RO will create all information on the appointment for you except for the Service Subject, Resource, Description (optional), and
Start/End Date/Time. You are linking directly to the specific Service Issue on the RO with each appointment. The appointment will create a
labor line using the Default Op/Rate codes for the Resource if that Resource is a Service Technician. No other information will be written to
the RO from the Appointment. The RO information will display on the appointment, but does not change your Appointment Description or
Date/Times.

Creating a New RO from the appointment will populate the Customer, Service Writer, Service Type, Wholegood and Description as input on the
appointment. If the Service Resource chosen is a Service Tech, they system will create a Labor Line using the Default Op/Rate codes for the
Resource. At this point, the Service Issue Description and Appointment Description are separate and can be edited separately.

After an RO and an Appointment are linked, no information will be written to or from the RO and the Appointment with the exception of a
Labor Line (if you change the Service Resource to a different Technician). You can change the RO linked to an appointment by clicking on the
Link to Existing RO button and choosing a different RO/Service Issue. This will update the Customer, Wholegood, Service Writer, and Service
Type on the Appointment. It will not change the Appointment Description if you typed one on the Appointment.

You have the ability to create multiple appointments for each RO tied to individual service issues on multiple dates/times. You can also assign
multiple technicians to a single service issue on multiple dates/times.

You can create appointments tied to Service Estimates only if the option to “Allow Time Entry” is checked on the Service Estimate.

You cannot link an appointment with a Service Technician assigned when that Repair Order is open on your workstation. You will need to save
and close the RO before creating the linked appointment. You can re-open the RO from the appointment after linking.

Below are examples of Creating an Appointment by Linking to an Existing RO and Creating an RO from an existing appointment.



1. Example of Manually Setting up Appointment then creating RO from Appointment.

Service - Appointment [ = o X
it - Save & Close  Create Mew / Goto RO
itac
iste sybject: . Service { v | Customer: Carl Albar (1920)
m Wholegood: tracteur neuf (35a) =+ Resource: SMITH, ELAIME -
Make [ Model: AGCO [ Service Writer: Dale Teague -
W' Serial Number: 1234567 Service Type: BILLABLE CLUSTOMER -
Reg
Description: Bringing in to diagnose sluggish start.
isto
Start time: 7/22/2019 w | 1:00 PM -
End time: 7/22/2019 * || 2:00FM z
1 By
Link to Existing RO
ROz Service Issue #: RO Date:

1 Service Issy

Example of manually setting up an
appointment. I added all of the highlighted
items.

m




New Repair Order

File Save

Save and Close

Save and Mew  Print  Credit Cards

Capture Signature

Update Line [tern Data

Show Open Documents

Custom Forms

J General Info | Service Issues I Items | Labar | Motes I Attachments | Print History | Preventative Maintenance | Document Register | Document Register Detail | Order Status F

Document Type | Repair Order Doc, £ 0 Inv. # |0 CC Auth, # Completion Status | Open T Project
Initiation Date | 7/22/2019 * | Customer PO # Salesman: = | Cust. Inv. Status Sub Project #:
Settement Date Service Writer  Dale Teague T \War. Inv. Status
Internal Memo Service Type BILLABLECU... -
Exp. StartDate | 7/22/2019 1:00 PM ~ | Exp. Comp. Date | 7/22/2019 2:00 PM - Extract Date | 1/1/0001
Printed Memo
Customer Name and Address Wholegood Information Shipping Information
Name @[Els WGID  (356) 7654321 In Service ~|  []shipTo Shipping Metho
Address 1 Make AGCO Serial # 1234567 Shipment Date:
Address 2 Model Lic. Plate State Address 1:
City Description | tracteur neuf Lic. Plate £ Address 2:
State Zip Code Year Fleet Mumber City:
Primary Contact State:
Odometer In | 0.0 Cdometer Out 0.0
Hours In 0,0 Hours Out (0,0

Hide Customer Information (F3)

Items
Customer &0.00
Warranty 20,00
Internal £0.00
Total £0,00

I dicked "Create New/Go to RO" on the appointment.

The system created this RO for me with the information
already populated from the appointment.

Subtotal

Tax Group

Customer Deposit

Original Deposil £0.00
Deposit Applied £0.00
Unused Deposil £0.00

Create Deposit | | Return Deposit



New Repair Order

File Save Saveand Close Saveand Mew | Print || Credit Cards | Capture Signature  Update Line [tern Data  Show Open Document

General Info | Service Issues | Items | Labar | Motes | Attachments | Print History | Preventative Maintenance | Document Register | Docume

| Add Mew Service Issue | | Add Standard Service Issue |

The description I typed into

Service Issue Issue #  Suppress  Description the appointment populated
Type e as the Service Issue
v ol = e description on the New RO.
" Customer 1 0 Sgr%ing in to diagnose sluggish

@ RIMSS. WinNetstar vB.0.0.908 Enterprise:The Enterprise Company:Hepburn Signature (669) Location:San Antonio (671)

File View Company Custorner Motes Receivable CRM  Suppliers  Employees  Payroll  Banking  Fixed Assets  |nventory  Service  Wholego

| RIMSS WinMetStar | Telephaony I Service Appointments - San Antonio | Service Repair Order - 2 X|

File Save Saveand Close Saveand Mew Print  Credit Cards  Capture Signature  Update Line ltern Data  Show Open Documents  Custom Forms

| General Info I Service Issues | Items | Labor | Motes | Attachments | Print History I Preventative Maintenance I Document Register | Document Register Detail | On

| Add New Labor | | Bill Estimated Hours | | Bill Standard Hours | | Bill Actual Hours | | Apply Discount
Service Issue | Issue # Technician Op Code  Description Rate Code | Std. Hours | Estimated | Actual Hours | Billed Hours | Rate Hourly or
Hours
] Bring... = 1 ELAIME SMITH LABOR. STAMDA... Labor 0.0000 0.0000 0.0000 0.0000 £75.00 Hourly

A labor line was added for the technidan using the Default Op/Rate codes.




2. Example of Creating an Appointment by Linking to an existing RO.

Service - Appointment [ = a x
Save & Close  Create New / Goto RO

| Subject: . Service * | Customer: Cash Customer (51)
Wholegood: o REsource: Jackson, Moto -
Make [ Model: Service Writer: -
Serial Mumber: Service Type: -
Description: T I open the appointment by

selecting the Resource and Time
of the appointment which wiill
auto-fill. T choose the Subjectifl
do not want the Default. Ithen
dick "Link to Existing RO".

Start time: 7/22/2019 - |5:00 PM

Ak AP

End time: 7j22/2019 - |5:00 PM

Link to Existing RO

RO# Service Issue #: RO Date:

Service Issue Desc:




RO Service Issues Lookup

Document Date
Mumber

3 7j222019

Type Status

e {6 (3

Complaint
Mumber

Customer Name  Fleet Make
Number

Service Issue Stock Mumber

e e

This will bring up a list of all open Service
Issues. I double-Click the one I want to

Repair Crder  Open 1 1:Bringingin t... Carl Albor choose for my appuintment_
2 7/22/201% Repair Order Open 1 1:Bringing in t... Carl Albor AGCO 7654301
| 1 7/22/2012 Estimate  Open 1 1:Ratte unde... Carl Albor | 12312321

Service - Appointment [ = (=]

Save & Close  Create Mew / Goto RO
Zoom ]
Subject: . Service -
Resource: Jackson, Maoto

Make [ Model: J RANGER. 500

Serial Mumber: 1711212
The Repair Order will populate

Description: the information from my RO onto
the appointment. I can add
additional notes to the
Appointment description if
desired. If not, I can just
Save&C(Close.

Start time: 7/22/2019 ~ || 5:00 FPM s

End time: 7/22/2019 ~ | 6:00FM s
Link to Existing RO

RO#: 1 Service Issue #: 1 RO Date: | 7/22/2019

Service Issue Desc:

1:Rattle under the hood. Need diagnosis and estimate for repair,



Additional Menu Options
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The menu at the top of the calendar has two tabs. The Home tab gives basic navigation
and view options. The View tab allows you to set more advanced options on the calendar
view. The calendar defaults to the Home menu tab when opening. You can toggle
between the menus while working in the calendar by dicking on Home or View.
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Grouping options slightly
change the way the header
shows on the calendar.

1. Refresh will update the calendar with any changes since you opened the tab.
2. New Appointment will open the pop-up to create a new appointment.
3. You can delete an appointment after selecting it on the calendar.

4. Backword /Forward will move you one day/time period forward or backword on the Calendar.

5. Go To Today will bring the calendar to the current date.
6. Zoom In/Zoom Out will change the amount of detail shown (hours/days/weeks/months)

7. Day View allows you to see all Resources across the top and the hours down the left side for the current day.
8. Timeline View shows all resources on the left side and days/weeks across the top for a multi-day view.
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1. You have the options to switch between Day and Timeline view on this menu.
2. You can choose Time Scales depending on the view.
a. Day View - you can change the increments per hour detail view (from 5 minutes to 1 hour)
b. Timeline View - you can change the increments to per day or week.
3. You can adjust the Scale Width and Captions (Header Detail) in Timeline View.
4. Working Hours will toggle Day View between a 24 hour day and the specified hours of your work day.
5. Work Start/End Time - specify the hours shown on the calendar when "Working Hours" is turned on.
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In Timeline View, you can
dick and drag an
appointment to the same
time on a different day. If
there is more than one
appointment, the earliest
will show on top. As eachis
moved, the next
appointment will appear in
order of time.

5:00
PM-G:0
0 PM

Service

RO 1
Service

Issue 1
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Menday, i ¥y Day View, you can dick and drag

the start or end time to change the
start or end time. You can also move

the entire appointment to a different
time with a dick-drag.
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out if you hover over the
file tab on the left side of
the calendar. You can pin
this on the page by dicking
on the pin on the top right
of the Date Navigator.

You can use this to
navigate to a spedfic date.

Additionally, you can
highlight a date range to
show more than one day
on the Day View. You will
have to select a single day
on the Date Navigator to
return to the normal Day
View.




LIOMN, DAMIEL
Monday, July 22

Jackson, Moto
Monday, July 22

If you Right-Click on the service calendar,
you have the options to start a New
Appointment, Go to Today's date, Pop up a
Date Navigator, or change from Day View to
Timeline View.

[F] MNew Appointment

Go to Today
[E GotoDate..

Change View To k

1:00 PM-2:00 PM Service
Open
Label A= »

¥ Delete

If you Right-Click on an
appointment, you have the options
to Open the appointment, Change
the Subject/Color (Label As), or
Delete the Appointment.




